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Chapter 7
Parametric Modeling Fundamentals
- Autodesk Inventor

Create Simple Extruded Solid Models

¢ Understand the Basic Parametric
Modeling Procedure

¢ Create 2D Sketches

¢ Understand the “Shape before Size”
Approach

¢ Use the Dynamic Viewing Commands

¢ Create and Edit Parametric Dimensions
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Getting Started with Autodesk Inventor

»2 AUTODESK

Autodesk Inventor is composed of several application software modules (these modules
are called applications) all sharing a common database. In this text, the main
concentration is placed on the solid modeling modules used for part design. The general
procedures required in creating solid models, engineering drawings, and assemblies are
illustrated.

How to start Autodesk Inventor depends on the type of workstation and the particular
software configuration you are using. With most Windows systems, you may select
Autodesk Inventor on the Start menu or select the Autodesk Inventor icon on the
desktop. Consult your instructor or technical support personnel if you have difficulty
starting the software. The program takes a while to load, so be patient.

The tutorials in this text are based on the assumption that you are using Autodesk
Inventor’s default settings. If your system has been customized for other uses, contact
your technical support personnel to restore the default software configuration.

All apps

w Autcdesk Inventor 2023
Mew

"{F Add-In Manager 2023

WE Autodesk App Manager

Autodesk Inventorgofessfonal 2023 - English
—I Mew

B Design Assistant 2023
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The Screen Layout and Getting Started

Once the program is loaded into the memory, the Inventor window appears on the screen
with the Get Started options activated.

Ho-& Il ad Autodesk Inventor Professional 2023 } Search Help & Comman: ds. L, signin W @ = O &
>t B @ Boemtuer af B Dvetumcor Sumone e
Ot (s B T ey s
Options ~ Content Center Logic Web Team Web -
Recent
Inventor 2023 =
Default o B I
cbC There is nothing here yet.
New. v
To get started, create or open a document.
What's New ®
Help
Tutorials
App Store.
£} Home =
What's New ® % Note that the /nventor Browser section contains helpful
information in regard to using the Inventor software. For
Help example, clicking the What’s New option will the list
. of new features that are included in this release of
Tutorials
Autodesk Inventor.
Commiinity

Inventor Browser section.

What's New ®
Help
Tutorials
Community

App Store
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» You are encouraged to browse through the different information available in the
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Place
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The New File Dialog Box and Units Setup

When starting a new CAD file, the first thing we should do is to choose the units we
would like to use. We will use the English (feet and inches) setting for this example.

- - E? E - - ﬁ 1'
Tnnle Cnllahorate {1
— Mew (Ctrl+ M)
= »Y |
Application Document Migrate A
Options Settings  Settings Apy

_] Create Mew File

v _ Temnplates
v _ en-Us
Metric

o EnglisrL\?

Mald Design

Select the New icon with a single click of the left-
mouse-button in the Quick Access toolbar.

Note that the New option allows us to start a new
modeling task, which can be creating a new model
or several other modeling tasks.

2. Select the en-US->English tab in the New File
dialog box as shown. Note the default tab contains
the file options which are based on the default units
chosen during installation.

3. Select the Standard(in).ipt icon as shown. The different icons are templates for the
different modeling tasks. The idw file type stands for drawing file, the iam file type
stands for assembly file, and the ipt file type stands for part file. The ipn file type
stands for assembly presentation.

~ T Templates
v 70 enUs
T3 English
= Metric
7 Mold Design

¥ Part - Create 20 and 30 objects

Sheet Standard
Metal | (in).ipt
(in).ipt

¥ Assembly — Assemble 2D and 3D components

&8 &

Mold  Standard Weldment
Design  (in).iam (AMSI).iam
(in).iam

¥ Drawing - Create an annotated document
[ SO a]
| 1
'S
ANSI ANSI
(in).dwg (in).idw

¥ Presentation - Create an exploded projection of

=]
L
Standard

fin) inn

Project File: Default.ipj

File: @ standard (n).ipt
Display Name: Fart
Units: inch

Materiak: Generic

This template creates a 20

object composed of features and one

or more bodies.

L0 Create New File b4

or 30

Cancel

4. Click Create in the

Create New File
dialog box to accept
the selected settings.
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The Default Autodesk Inventor Screen Layout

The default Autodesk Inventor drawing screen contains the pul/l-down menus, the
Standard toolbar, the Features toolbar, the Sketch toolbar, the drawing area, the browser
area, and the Status Bar. A line of quick text appears next to the icon as you move the
mouse cursor over different icons. You may resize the Autodesk Inventor drawing
window by clicking and dragging the edges of the window, or relocate the window by
clicking and dragging the window title area.

Quick Access Toolbar Ribbon Toolbar
File Menu
D-FHS v B AW %@ Geneic ~@ Woefautt -~ @ @& fr + = Part] Search Help & Commands... &, Sign In W @ = B &
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|E|\. !T :ﬂ 25 Sweep ) Emboss 5 Decal &) Chamfer = Thread = gpiit a3 @ - A rj ¢ HRE ¢4 e ®-
122 . & . L , 3 - A
Start Extrude Revolve U Loft -'_j Derive Q Import Hole  Fillet D Shel ’ Combine [l Direct Shape Plane ‘> Box L_‘ Q * @ Stress. Convert to
2D Sketch ™ = Coil [k, Rib 1 Unwrap v [ Draft &P Thicken/ Offset = Delete Face Generator 11, En & @& B EZ  pnalysis  Sheet Metal

Sketch Create Modify + Explore =~ Work Features = Pattern = Create Freeform Surface Simulation Convert

Model X+ Q= -OX

W partt

+ 7] Model States: [Primary]
+ T2 view: [Primary]
b Feature Create

O Endof Part Toolbar Panel
@
Model i ;
ode Graphics ¢
Browser ' :
Window c)

3D Indicator

L

orx

{2 Home Tutorials X _Partl X

For Help, pressF1

Message or Single-line Help

e The Ribbon Toolbar is a relatively new feature in Autodesk Inventor; the Ribbon
Toolbar is composed of a series of tool panels, which are organized into tabs labeled
by task. The Ribbon provides a compact palette of all of the tools necessary to
accomplish the different modeling tasks. The drop-down arrow next to any icon
indicates additional commands are available on the expanded panel; access the
expanded panel by clicking on the drop-down arrow.
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e File Menu

._ID'BE@' 'G}E I3'-._H'9-®Ger1eric
3D Model ~ Sketch  Annotate Inspect Tools  Manage The Flle menu at the upper left corner Of the
oy main window contains tools for all file-
@O = Export .
related operations, such as Open, Save,
D Rew ' a IET:githe file in image file format EXport, etC.
such as BMP, JPEG, PNG, or TIFF,
@ Open 3
PDF

% Exportthe file in PDF file format.
@~ 3DPDF
P Export to a 30 PDF file.
E Save As 3
B
[

CAD Format

Export the file in another CAD file
format such as Parasolid, PRO-E, ar
STEP.

C% Share ]
RVT

e Quick Access Toolbar
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The Quick Access toolbar at the top of the Inventor window allows us quick access to
file-related commands and to Undo/Redo the last operations.

e Ribbon Tabs and Tool panels

OO DH< = OB b - %@ Greic - @ @ocat - @ @ |
3D Model  Sketch  Annotate  Inspect  Tools  Manage View  Envircnments  Collaborate

EIT. ! hﬂ j Sweep _\1 Emboss LH_.-| Decal - D @ Chamfer % Thread

;lrt ] Extruts Revolve .'O‘ Loft G54 Derive 'D Import Hole Fillet D Shell ' Cu:u.mhine

2D Sketch E Coil &; Rib {j‘i Unwrap - G\ Draft &F Thicken/ Of

Sketch Extrude (E:| Ml:ldlf_'f &7

The Ribbon is composed of a series of tool panels, which are organized into tabs labeled
by task. The assortments of tool panels can be accessed by clicking on the tabs.

e Online Help Panel

b Search Help & Commands.. L rshin - ® ‘[} - 0O X

Click here to access the help

& face Bl stitch ‘ Ruled Surface ﬂ # ‘ . o

The Help options panel provides us with multiple options to access online help for
Autodesk Inventor. The Online Help system provides general help information, such as
command options and command references.
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e 3D Model Toolbar

3D Model  Sketch  Annotate  Inspect Tools Manage View  Environments GetStarted  Collaborate

— L - |~ [ = oo
s !T ) o) Sweep % Emboss 3 Decal ‘ O Chamfer = Thread 3 Split
—h

] i > - L

_— Extrude Revolve U Loft @2 Derive D Import Hole Fillet D Shell ’ Combine f‘ Direct

2D Sketch = coil (& Rib & Unwrap (W Draft & Thicken/ Offset ' Delete Fa
Sketch Create Modify =

The 3D Model toolbar provides tools for creating the different types of 3D features, such
as Extrude, Revolve, Sweep, etc.

e Graphics Window

FRONT

A

.

{2t Partl X

The graphics window is the area where models and drawings are displayed.

e Message and Status Bar

it Part1 %

| Select start of line, drag off endpoint for tangent arc ﬁa [“’: l’—L-i v Cg "'. “'

0428in, 136.25deg 1 1

The Message and Status Bar area shows a single-line help when the cursor is on top of an
icon. This area also displays information pertinent to the active operation. For example,

in the figure above, the coordinates and length information of a line are displayed while
the Line command is activated.
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Mouse Buttons

Autodesk Inventor utilizes the mouse buttons extensively. In learning Autodesk
Inventor's interactive environment, it is important to understand the basic functions of the
mouse buttons. It is highly recommended that you use a mouse or a tablet with Autodesk
Inventor since the package uses the buttons for various functions.

e Left mouse button
The left mouse button is used for most operations, such as selecting menus and
icons, or picking graphic entities. One click of the button is used to select icons,
menus and form entries, and to pick graphic items.

e Right mouse button
The right mouse button is used to bring up additional available options. The
software also utilizes the right mouse button the same as the ENTER key and is
often used to accept the default setting to a prompt or to end a process.

e Middle mouse button/wheel
The middle mouse button/wheel can be used to Pan (hold down the wheel button and
drag the mouse) or Zoom (turn the wheel) realtime.

Brings up additional available
Allows quick Pan options. Also used to accept the
and Zoom. ' default option of a command, or
end a process.

Picks icons, menus,
and graphic entities.

[Esc] — Canceling Commands

The [Esc] key is used to cancel a command in Autodesk Inventor. The [Esc] key is
located near the top-left corner of the keyboard. Sometimes, it may be necessary to press
the [Esc] key twice to cancel a command; it depends on where we are in the command
sequence. For some commands, the [Esc] key is used to exit the command.
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Autodesk Inventor Help System

Sign In v ® | — O &2
Help b N R Seve?al type§ of help are available at
any time during an Autodesk Inventor
irfg Learn More » : :
session. Autodesk Inventor provides
Connect ’ many help functions, such as:
Team Web

e Use the Help button near the upper
right corner of the Inventor window.

v Show Get Started Tab

Desktop Analytics
e Help quick-key: Press the [F1] key to

About Autodesk Inventor Professional
access the Inventor Help system.

b Sweep L Rrshih
All (291) Commands (3) Developer's Documf @  Use the Info Center to get information on
— Learn & Explore (54) Getting Started (1) a speciﬁc tOpiC.

Y » Commands

plai F5) Sweep

ﬁ !\ Inventor 2022 Help | "Sweep™ | £ X + - o 3
@] (3 https://help.autodesk.com/view/INVNTOR/2022/ENU/?query=Sweep Y6 = @
4 Help Home Randy Shih + G English (US) +

| AUTODESK' INVENTOR 2023

Showing 1-15 of 524 results for Sweep (0.45 seconds)

To Create Sweeps

Knowledge Source In the Sweep dialog box, click Profile and then select the profile to sweep .
Accepted Solutions In Forums (305) Product Documentation | 2021-04-15
Product Documentation (219)

3D sweep features
Use these tips to help create 3D sweep features: Usually, in an assembly, create a separate part file for a

Information Category 3D sweep feature.

. Product Documentation | 2021-04-15
Developer's Documentation (160)

Learn & Explore (59) Create 3D sweeps in an assembly

On the ribbon, click 3D Model tab Create panel Sweep .
Product Documentation | 2021-04-15

Content Type
Reference (168) About Sketched Features
Task (17) Sweep Sweep features or bodies are created by moving a solid body or one or more sketch profiles along
a path
Concept (11) Product Documentation | 2021-04-15

Part Enhancements

o Solid Sweep An Inventor® Ideas submission In addition to a new property panel for a streamlined
Individual User (305) workflow, Solid Sweep enables sweeping a solid toolbody along a path.

Autodesk (219) Product Documentation | 2021-04-13

Content Provider

About Position Geometry for iFeatures
User Type Position Geaometry for iFeatures with Sweens For some iFeatiire uch as an O-ring aroove created with a h

e Use the Internet to access information on the Autodesk community website.
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Data Management Using Inventor Project files

With Autodesk Inventor, it is quite feasible to create designs without any regard to using
the Autodesk Inventor data management system. Data management becomes critical for
projects involving complex designs, especially when multiple team members are
involved, or when we are working on integrating multiple design projects, or when it is
necessary to share files among the design projects. Autodesk Inventor provides a fairly
flexible data management system. It allows one person to use the basic option to help
manage the locations of the different design files, or a team of designers can use the data
management system to manage their projects stored on a networked computer system.

The Autodesk Inventor data management system organizes files based on projects. Each
project is identified with a main folder that can contain files and folders associated to the
design. In Autodesk Inventor, a project file (.ipj) defines the locations of all files
associated with the project, including templates and library files.

The Autodesk Inventor data management system uses two types of projects:
» Single-user Project
» Autodesk Vault Project (installation of Autodesk Vault software is required)

The single-user project is for simpler projects where all project files are located on the
same computer. The Autodesk Vault project is more suitable for projects requiring
multiple users using a networked computer system.

1. Click on the Projects icon with a single click of the left-mouse-button in the [File]
- [Manage] pull-down menu.

JD*E‘FE‘Q:“' Qj

% 3D Model  Skef
cﬁ':—rj ng
Share ¥

Nhew I

5 r'.-'lanlja\;e K
[ 3

Ii' _ _ Manage

% Projects

Create ar ed&prnjects.

View iFeature Catalog
[— Openthe iFeature folderina

% The Projects Editor appears on the screen, which allows us to access the settings of
new or existing Inventor Single User Project or Autodesk Vault Project.
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¢ In the Projects Editor: the Default project is available.

Projects X

Praject name - Project location

v DEEN

ke Project (read only) -
&% Type = Single User
1 Included file = -
ofe Use Style Library = Read-Only

@ Appearance Libraries

@ Material Libraries +
% workspace
& Workgroup Search Paths Ve
& Libraries
&3 Frequently Used Subfolders o]

A Folder Options

* Options

B opti

z New Browse... Save Apply

The Default project is automatically active by default, and the default project does not
define any location for files. In other words, the data management system is not used.
Using the default project, designs can still be created and modified, and any model file
can be opened and saved anywhere without regard to project and file management.

Set up of a New Inventor Project
In this section, we will create a new Inventor project for the chapters of this book using
the Inventor built-in Single User Project option. Note that it is also feasible to create a

separate project for each chapter.

1. Click New to begin the setup of a new project file.

T Tibraries

4 Frequently Used Subfolders
% Folder Options
@ Options

o wovse..
w
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2. The Inventor project wizard appears on the screen; select the New Single User
Project option as shown.

Inventor project wizard X

What type of project are you creating?

@lgew Single User Project

() New Vault Project

3. Click Next to proceed with the next setup option.

4. In the Project File Name input box, enter Parametric-Modeling as the name of the
new project.

Inventor project wizard X

Project File

MName

|Parametric—M0deIing

Project (Workspace) Folder
| C:\Users\randy\Documents\Inventor\Parametric-Modeling), |

Project File to be created

| C:\Users\rand'_.r\Documents\[nventor\Parametric—ModeIing\Parametric—ModeIing.ip|

=) Back Next Finish Cancel

5. Inthe Project Folder input box, note the default folder location, such as
C:\Users\Documents\inventor \Parametric Modeling\, and choose a preferred
folder name as the folder name of the new project.

6. Click Finish to proceed with the creation of the new project.
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Inventor Project Editor

The project path you entered doesn't exist.
Should it be created?

OK Cancel

7. A warning message appears on the
screen, indicating the specified
folder does not exist. Click OK to
create the folder.

8. A second warning message appears on the screen, indicating that the newly created
project cannot be made active since an Inventor file is open. Click OK to close the

message dialog box.

Autodesk Inventor Professional 2023

| The active project cannot be changed while Inventor files are open.

|

e The new project has been created and its name appears in the project list area as

shown in the figure.

Projects

Project name Project location
v Default

Parametric-Modeling C:\Users\randy\Documents\Inventor\Parametric-Modeling',

9. Click Done to exit the Inventor Projects Editor option.
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The Content of the Inventor Project File

An Inventor project file is actually a text file in .xml format with an .ipj extension. The
file specifies the paths to the folder containing the files in the project. To assure that links

between files work properly, it is advised to add the locations for folders to the project
file before working on model files.

| + | Parametric-Modeling

- O X
Home Share View v 0
« v 4 <« Inventor » Parametric-Modeling v ) Search Parametric-Modeling r
~
# Quick access
[ Desktop » =
OldVersions  Parametric-
¥ Downloads » MDdElﬁg‘i
Documents * o]
=] Pictures 4 j Parametric-Modeling.ipj - Notepad - a X
19-04-ACAD2D File Edit Format View Help
? ion="1.0" ing="utf-16" ="no" ?
19-04-PM-Inventor lc2xm1 version="1.0 encoding utf 15- lstandalone. no" ?> . o
<InventorProject contentcenterguid="oiaesfbabtfrionmeynffsgvfb” schemarevid="14">
19-05-P&P
<AddInConfigs>
temp <AutodeskIntent configguid=" ">
</AddInConfigs>
#& OneDrive
<ProjectOptions>
= This PC <ProjectType>None</ProjectType>
. <IncludedProject></IncludedProject>
-3 3D Objects <0ldVersionsToKeepOnSave>1</0OldVersionsToKeepOnSave>
[ Desktop <UsinguniqueFilenames>Yes</UsingUniqueFilenames>
<Owner><,/Owner>
Documents <ReleaseID></ReleaseID>
<ImportedCompFolder>Imported Components</ImportedCompFolder>
‘ Downloads <ImportedAsmFolder>TImported Components</ImportedAsmFolder>
e P P P P
[ </ProjectOptions>
2 items
<AppearanceProteinLibraries>
<ProteinLibrary>
<path></Path>
<ProteinLibraryType>1</ProteinLibraryType>
<ActiveProteinLibrary>e</ActiveProteinLibrary>
</proteinLibrary>
<ProteinLibrarys>
<path></Path>
<ProteinLibraryType>2</ProteinLibraryType>
<ActiveProteinLibrary>e</ActiveProteinLibrary>
PO TN
< >
Unix (LF) Ln 1, Col 1 100%

Leaving Autodesk Inventor

To leave the Application menu, use the left-mouse-button and click on Exit Autodesk
Inventor from the pull-down menu.

'_'|DvE'rElf:=.v

% 3D Model  Skef
Pl

| M ew b

Options Exit Autodesk Invemc&Professional
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Feature-Based Parametric Modeling

The feature-based parametric modeling technique enables the designer to incorporate
the original design intent into the construction of the model. The word parametric means
the geometric definitions of the design, such as dimensions, can be varied at any time in
the design process. Parametric modeling is accomplished by identifying and creating the
key features of the design with the aid of computer software. The design variables,
described in the sketches as parametric relations, can then be used to quickly
modify/update the design.

In Autodesk Inventor, the parametric part modeling process involves the following steps:

1. Create a rough two-dimensional sketch of the basic shape of the base feature
of the design.

2. Apply/modify constraints and dimensions to the two-dimensional sketch.

3. Extrude, revolve, or sweep the parametric two-dimensional sketch to create
the base solid feature of the design.

4. Add additional parametric features by identifying feature relations and
complete the design.

5. Perform analyses on the computer model and refine the design as needed.
6. Create the desired drawing views to document the design.

The approach of creating two-dimensional sketches of the three-dimensional features is
an effective way to construct solid models. Many designs are in fact the same shape in
one direction. Computer input and output devices we use today are largely two-
dimensional in nature, which makes this modeling technique quite practical. This method
also conforms to the design process that helps the designer with conceptual design along
with the capability to capture the design intent. Most engineers and designers can relate
to the experience of making rough sketches on restaurant napkins to convey conceptual
design ideas. Autodesk Inventor provides many powerful modeling and design tools, and
there are many different approaches to accomplishing modeling tasks. The basic principle
of feature-based modeling is to build models by adding simple features one at a time. In
this chapter, the general parametric part modeling procedure is illustrated; a very simple
solid model with extruded features is used to introduce the Autodesk Inventor user
interface. The display viewing functions and the basic two-dimensional sketching tools
are also demonstrated.
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The Adjuster Design

o

Starting Autodesk Inventor

1. Select the Autodesk Inventor option on the Start menu or select the Autodesk
Inventor icon on the desktop to start Autodesk Inventor. The Autodesk Inventor
main window will appear on the screen.

All apps
- Autodesk Inventor 2023
o Mew

d}l Add-In Manager 2023

Autodesk App Manager

Autodesk Inventor[gofessionai 2023 - English
Mew

B ar

Design Assistant 2023

Inventor 2023

Se&iﬁgs. -

= |

P tric-Modeling ., i i l
R 2. Select the Settings option next to the Projects

icon with a single click of the left-mouse-button.

| New._.
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3. Inthe Projects List, confirm the Parametric-Modeling project is activated as the
activate project as shown.

Projects X
sy
Project name Project location
Default
" Parametric-Modeling % C:\Users\randy\Documents\Inventor\Parametric-Modeling\,

e Note that Autodesk Inventor will keep this activated project as the default project
until another project is activated.

4. Click Done to accept the setting and end the Projects Editor.

Parametric-Modeling v'
5. Select the New File icon with a single click of the

left-mouse-button as shown in the figure.
Open... . . . . .
e Notice the Parametric-Modeling project name is

displayed above as the active project.
New . w

U

6. Select the en-US - English tab as shown below. When starting a new CAD file, the
first thing we should do is choose the units we would like to use. We will use the
English setting (inches) for this example.

Ll Create New File

vl : ¥  Part —Create 2D and 3D objects
v T en-US 6. English
T2 English / i '
~ Metric
__ Mold Design Sheet Standard

Metal (in).L\Gd:
(in).i

7. Standard-lpt ¥  Assembly — Assemble 2D and 30 components

586 8 e ®

Mold Standard Weldment Display Na
Design (in).iam (ANSI).iam Units: inch

7. Select the Standard(in).ipt icon as shown.

8. Pick Create in the New File dialog box to accept the selected settings.
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The Default Autodesk Inventor Screen Layout

The default Autodesk Inventor drawing screen contains the pul/l-down menus, the
Standard toolbar, the 3D Model toolbar, the Sketch toolbar, the drawing area, the browser
area, and the Status Bar. A line of quick text appears next to the icon as you move the
mouse cursor over different icons. You may resize the Autodesk Inventor drawing
window by clicking and dragging the edges of the window, or relocate the window by
clicking and dragging the window title area.

Quick Access Toolbar Ribbon Toolbar
File Menu /
HOfCH<- = @B L - U.@< ~@ Wocfaut ~@ & fr + = Part] # Search Help & Comman ds.. K Signin - @- = @
IDModel Sketch  Annotate Inspect Tools Manage View Environments Collsborate Fusion380 )«
“/ “"‘ 5 Sweep \Emh s 3 Decal O(Hmf Z Thread 5 spit 'lel ¢ HRE ¢4 @-
D W&o - D Goa Gomn g @ B % wse oSS
2D Sketch ™ = Coil Q;Rm i Unwrap (¥ Draft &P Thicken/ Offset =3 Delete Face Gens tm Tg, Ea o @ B EG Analysis | Sheet Metal
Sketch Create Modify = Explore | WorkFestures  Pattern  Create Freeform | Suface  Simulation  Convert
Model X+ Q= -EX
@ partt
+ el States: [Primary]
+ 5o View: [Primary]
+ FRONT
@ Entorrar Create Toolbar Panel
ig:n
Graphics &
Window &
Model
Browser
/ 3D Indicator
v
Y
e
£} Home Tutorisls X _Partl X =
1 1

For Help, presng

\ Message or Single-line Help

The Ribbon Toolbar is a relatively new feature in Autodesk Inventor; the Ribbon
Toolbar is composed of a series of tool panels, which are organized into tabs labeled by
task. The Ribbon provides a compact palette of all of the tools necessary to accomplish
the different modeling tasks. The drop-down arrow next to any icon indicates additional
commands are available on the expanded panel; access the expanded panel by clicking on
the drop-down arrow.
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Sketch Plane — It is an XY monitor, but an XYZ World

Design modeling software is becoming more
powerful and user friendly, yet the system
still does only what the user tells it to do.
When using a geometric modeler, we
therefore need to have a good understanding
of what its inherent limitations are.

xu“ll»\

g
In most 3D geometric modelers, 3D objects
are located and defined in what is usually
called world space or global space.
Although a number of different coordinate
systems can be used to create and manipulate
objects in a 3D modeling system, the objects
are typically defined and stored using the
world space. The world space is usually a 3D
Cartesian coordinate system that the user
cannot change or manipulate.
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In engineering designs, models can be very complex, and it would be tedious and
confusing if only the world coordinate system were available. Practical 3D modeling
systems allow the user to define Local Coordinate Systems (L.CS) or User Coordinate
Systems (UCS) relative to the world coordinate system. Once a local coordinate system
is defined, we can then create geometry in terms of this more convenient system.

Although objects are created and stored in 3D space coordinates, most of the geometric
entities can be referenced using 2D Cartesian coordinate systems. Typical input devices
such as a mouse or digitizer are two-dimensional by nature; the movement of the input
device is interpreted by the system in a planar sense. The same limitation is true of
common output devices, such as displays and plotters. The modeling software performs a
series of three-dimensional to two-dimensional transformations to correctly project 3D
objects onto the 2D display plane.

The Autodesk Inventor sketching plane is a special construction approach that enables
the planar nature of the 2D input devices to be directly mapped into the 3D coordinate
system. The sketching plane is a local coordinate system that can be aligned to an
existing face of a part, or a reference plane.

Think of the sketching plane as the surface on which we can sketch the 2D sections of the
parts. It is similar to a piece of paper, a white board, or a chalkboard that can be attached
to any planar surface. The first sketch we create is usually drawn on one of the
established datum planes. Subsequent sketches/features can then be created on sketching
planes that are aligned to existing planar faces of the solid part or datum planes.



7-20 Tools for Design: Using AutoCAD and Autodesk Inventor

HDO-EHS -~ 0B

3D Model ~ Sketch  Annotate

:1;, i !T ﬁ % Sweep

Loft
Start l} Extrude Revolve @

1. Activate the Start 2D Sketch icon with a
single click of the left-mouse-button.

2D Sketch
" 2D Sketch (5)
Sketch
¢ Creates a 20 sketch on a planar
Model 3 | on a work plane on an assembl

2. Move the cursor over the edge of the XY Plane in the graphics area. When the XY
Plane is highlighted, click once with the left-mouse-button to select the Plane as the
sketch plane for the new sketch.

o The sketching plane is a reference location where two-dimensional sketches are
created. Note that the sketching plane can be any planar part surface or datum plane.

3. Confirm the main Ribbon area is switched to the Sketch toolbars; this indicates we
have entered the 2D Sketching mode.
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Create A Rough Sketch

Quite often during the early design stage, the shape of a design may not have any precise
dimensions. Most conventional CAD systems require the user to input the precise lengths
and locations of all geometric entities defining the design, which are not available during
the early design stage. With parametric modeling, we can use the computer to elaborate
and formulate the design idea further during the initial design stage. With Autodesk
Inventor, we can use the computer as an electronic sketchpad to help us concentrate on
the formulation of forms and shapes for the design. This approach is the main advantage
of parametric modeling over conventional solid-modeling techniques.

As the name implies, a rough sketch is not precise at all. When sketching, we simply
sketch the geometry so that it closely resembles the desired shape. Precise scale or
lengths are not needed. Autodesk Inventor provides many tools to assist us in finalizing
sketches. For example, geometric entities such as horizontal and vertical lines are set
automatically. However, if the rough sketches are poor, it will require much more work
to generate the desired parametric sketches. Here are some general guidelines for creating
sketches in Autodesk Inventor:

e Create a sketch that is proportional to the desired shape. Concentrate on the
shapes and forms of the design.

o Keep the sketches simple. Leave out small geometry features such as fillets, rounds
and chamfers. They can easily be placed using the Fillet and Chamfer commands
after the parametric sketches have been established.

o Exaggerate the geometric features of the desired shape. For example, if the
desired angle is 85 degrees, create an angle that is 50 or 60 degrees. Otherwise,
Autodesk Inventor might assume the intended angle to be a 90-degree angle.

e Draw the geometry so that it does not overlap. The geometry should eventually
form a closed region. Self-intersecting geometry shapes are not allowed.

e The sketched geometric entities should form a closed region. To create a solid
feature, such as an extruded solid, a closed region is required so that the extruded
solid forms a 3D volume.

» Note: The concepts and principles involved in parametric modeling are very
different, and sometimes they are totally opposite, to those of conventional computer
aided drafting. In order to understand and fully utilize Autodesk Inventor’s
functionality, it will be helpful to take a Zen approach to learning the topics presented
in this text: Have an open mind and temporarily forget your experiences using
conventional Computer Aided Drafting systems.
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Step 1: Creating a Rough Sketch

The Sketch toolbar provides tools for creating the basic geometry that can be used to

create features and parts.

Ho-H<s-+ B h-
3D Model Eaa' Annotate  Insp
FRyAONanE

Start Line{} Circle  Arc  Rectang
2D Sketch ™ T - 3 <
Sketch Line (L) te
Model ¥ 4 Creates lines and arcs.
J Part1

Press F1 for more help
+ Model States: [Primes gy ,

+- [%= View: [Primary]
+ Crigin
- Flsketchs

0 End of Part

Graphics Cursors

1. Move the graphics cursor to the Line icon in
the Sketch toolbar. A Help-tip box appears next
to the cursor and a brief description of the
command is displayed at the bottom of the
drawing screen: “Creates Straight lines and
arcs.”

2. Select the icon by clicking once with the left-
mouse-button; this will activate the Line
command. Autodesk Inventor expects us to
identify the starting location of a straight line.

Notice the cursor changes from an arrow to a crosshair when graphical input is expected.

1. Left-click a starting point for the shape, roughly just below and to the right of the

center of the graphics window.

2. As you move the graphics cursor, you will see a digital readout next to the cursor and
also in the Status Bar area at the bottom of the window. The readout gives you the
cursor location, the line length, and the angle of the line measured from horizontal.
Move the cursor around and you will notice different symbols appear at different

locations.

[\

&

The readout displayed next to the cursor is called the Dynamic Input. This option is

part of the Heads-Up Display option that is now available in Inventor. Note that
Dynamic Input can be used for entering precise values, but its usage is somewhat

limited in parametric modeling.
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3. Move the graphics cursor toward the right side of the graphics window and create a
horizontal line as shown below (Point 2). Notice the geometric constraint symbol, a
short horizontal line indicating the geometric property, is displayed.

Point1 K

Point 2
N /
. 0.00 de;
Constraint / :

Symbol

0.749in, -0.125 in x=0.642in y=0.000in 1 1

Geometric Constraint Symbols

Autodesk Inventor displays different visual clues, or symbols, to show you alignments,
perpendicularities, tangencies, etc. These constraints are used to capture the design intent
by creating constraints where they are recognized. Autodesk Inventor displays the
governing geometric rules as models are built. To prevent constraints from forming, hold
down the [Ctrl] key while creating an individual sketch curve. For example, while
sketching line segments with the Line command, endpoints are joined with a Coincident
constraint, but when the [Ctrl] key is pressed and held, the inferred constraint will not be

created.

| k Vertical

— Horizontal
—_—— Dashed line
\\ Parallel

\( Perpendicular
. Coincident

Tangent

Concentric

indicates a line is vertical
indicates a line is horizontal

indicates the alignment is to the center point or
endpoint of an entity

indicates a line is parallel to other entities

indicates a line is perpendicular to other entities

indicates the cursor is at the endpoint of an entity

indicates the cursor is at the center of an entity

indicates the cursor is at tangency points to curves
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1. Complete the sketch as shown below, creating a closed region ending at the starting
point (Point 1). Do not be overly concerned with the actual size of the sketch. Note
that all line segments are sketched horizontally or vertically.

Point6 "

\

/

Point 5

Point 4

/ Point 3

\

[ Une &)
| Center Point Cirde @J (=T

Cancel (ESC), X ] [

(_General Dimension [ ) (

[ «#* Finish 2D Sketch |

Point 1

\

Point 2

2. Inside the graphics window, click once with the
right-mouse-button to display the option menu.
Select Cancel [Esc] in the pop-up menu, or hit the
[Esc] key once to end the Sketch Line command.

Step 2: Apply/Modify Constraints and Dimensions

As the sketch is made, Autodesk Inventor automatically applies some of the geometric
constraints (such as horizontal, parallel, and perpendicular) to the sketched geometry. We
can continue to modify the geometry, apply additional constraints, and/or define the size
of the existing geometry. In this example, we will illustrate adding dimensions to

describe the sketched entities.

-

__ |
d| |4 5
Dimension =~ * 7 X 3|
s M St =

General Bimension (D)

Bl Image

| -
EE, Points

S ACAD

Places a dimension in a 2D or 3D sketch.

rrin

1. Move the cursor to the Constrain

toolbar area; it is the toolbar next to the
2D Draw toolbar. Note the first icon in
this toolbar is the General Dimension
icon. The Dimension command is
generally known as Smart
Dimensioning in parametric
modeling.



Parametric Modeling Fundamentals - Autodesk Inventor 7-25

Iy (@& B image |3 2. Move th.e cursor on top of the
= Dimension icon. The Smart
M 7z X 7 4 B¥ points

. Dimensioning command allows us to
. ™= 8§ acaD quickly create and modify dimensions.
B e e e T Left-click once on the icon to activate
the Dimension command.

Dimension

rrin

Places a dimension in a 2D or 3D sketch.

3. The message “Select Geometry to Dimension” is displayed in the Status Bar area at
the bottom of the /nventor window. Select the bottom horizontal line by left-clicking
once on the line.

3. Pick the bottom horizontal
line as the geometry to
dimension.

| 4. Pick a location below

the line to place the
/ dimension.

7

669

4. Move the graphics cursor below the selected line and left-click to place the
dimension. (Note that the value displayed on your screen might be different than what
is shown in the figure above.)

Edit Dimension:d0 X 5. Accept the default value by clicking on the Accept

| > ‘ button as shown.

+ The General Dimension command will create a length dimension if a single line is
selected.

6. The message “Select Geometry to Dimension” is displayed in the Status Bar area,
located at the bottom of the /nventor window. Select the top-horizontal line as shown
below.
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7. Select the bottom-horizontal line as shown below.

T~ | 6. Pick the top line as the
Ist geometry to dimension.

8. Place the dimension
_—" next to the sketch.

/

7. Pick the bottom line
as the 2nd geometry to
dimension.

669

8. Pick a location to the left of the sketch to place the dimension.

Edit Dimension : d1 X
prosr7: o ] button.

+* When two parallel lines are selected, the General Dimension command will create a

dimension measuring the distance between them.

= 167—=

9. Accept the default value by clicking on the Accept

10. On your own, repeat the above steps
and create additional dimensions
(accepting the default values created
by Inventor) so that the sketch
appears as shown.
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Dynamic Viewing Functions — Zoom and Pan

Autodesk Inventor provides a special user interface called Dynamic Viewing that enables
convenient viewing of the entities in the graphics window.

Zoom
| Zoom All

Zoom Window
Zoom Selected

<@@|

lo [} {6 C

5. Click on the Pan icon located above the Zoom command in the
Navigation bar. The icon is the picture of a hand.

» The Pan command enables us to move the view to a different position.
This function acts as if you are using a video camera.

6. On your own, use the Zoom and Pan options to reposition the sketch

near the center of the screen.

1.

Click on the Zoom icon located in the Navigation
bar as shown.

2. Move the cursor near the center of the graphics

window.

3. Inside the graphics window, press and hold down

the left-mouse-button, then move downward to
enlarge the current display scale factor.

4. Press the [Esc] key once to exit the Zoom

command.

<@@|

|0 IELCEWIBE%

Modifying the Dimensions of the Sketch

1. Select the dimension that is at the bottom of the
sketch by double-clicking on the dimension

text.

1. Select this dimension
to modify.

2. In the Edit Dimension window, the current L

length of the line is displayed. Enter 2.5 to

set the length of the line.

3. Click on the Accept icon to accept the

entered value.

A0
004

Edit Dimension : d0 *

|2.5| >| v

» Autodesk Inventor will now update the profile with the new dimension value.
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[==—.750—==

4. On your own, repeat the
above steps and adjust the
dimensions so that the
sketch appears as shown.

2.500

750

2,500

nage |- |HZH .,
5

bints || 2 M . In the Ribbon toolbar, click once with the left-
Finish mouse-button to select Finish Sketch in the

CAD £z Show Format  Ske{h Ribbon area to end the Sketch option.

ert Format « Exit

Step 3: Completing the Base Solid Feature

Now that the 2D sketch is completed, we will proceed to the next step: create a 3D part
from the 2D profile. Extruding a 2D profile is one of the common methods that can be
used to create 3D parts. We can extrude planar faces along a path. We can also specify a
height value and a tapered angle. In Autodesk Inventor, each face has a positive side and
a negative side; the current face we are working on is set as the default positive side. This
positive side identifies the positive extrusion direction and it is referred to as the face’s
normal.

'_'|D-ErEI<::- AR

20 Model R 1. Inthe 3D Model tab, select the Extrude

command by clicking the left-mouse-button

i ‘[ :ﬂ ¥ol Sweep on the icon as shown.
'— b Loft
Start Extl:\»}de Revolve
2D Sketch = Coil |
Sketch Extrude (E)
Model X <+ Creates a feature or body

profiles create solids or s

il part1
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2. In the Extrude edit box, enter 2.5 as the extrusion distance. Notice that the sketch
region is automatically selected as the extrusion profile.

Properties X +

Profiles
From

¥ Behavior
Direction

Distance A

Extrusion®> Sketch1®

¥ Input Geometry

&k D 1 Profile

& 7 1 Sketch Plane

25in

» Advanced Properties

Cancel

(Al X » -

o
I.

.

+

1500

750_
F ™

3. Click on the OK button to proceed with creating the 3D part.

» Note that all dimensions disappeared from the screen. All parametric definitions are
stored in the Autodesk Inventor database and any of the parametric definitions can
be re-displayed and edited at any time.

Isometric View

Autodesk Inventor provides many ways to display views of the three-dimensional design.
Several options are available that allow us to quickly view the design to track the overall
effect of any changes being made to the model. We will first orient the model to display
in the isometric view by using the pull-down menu.

1.

0

Hit the function key [F6] once to
automatically adjust the display and
also reset the display to the
isometric View.

Note that most of the view-related
commands can be accessed in the

ViewCube and/or the Navigation
bar located to the right side of the

graphics window.
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+» Dynamic Rotation of the 3D Block — Free Orbit

The Free Orbit command allows us to:
Orbit a part or assembly in the graphics window. Rotation can be around the
center mark, free in all directions, or around the X/Y-axes in the 3D-Orbit

display.

Reposition the part or assembly in the graphics window.
Display isometric or standard orthographic views of a part or assembly.

The Free Orbit tool is accessible while other tools are active. Autodesk Inventor
remembers the last used mode when you exit the Orbit command.

Eroy

&)

1. Click on the Orbit icon in the Navigation bar.

» The 3D Orbit display is a circular rim with four handles and a center mark. 3D Orbit
enables us to manipulate the view of 3D objects by clicking and dragging with the
left-mouse-button:

K

Handle

~

Center Mark

Drag with the left-mouse-
button near the center for
free rotation.

Drag on the handles to orbit
around the horizontal or
vertical axes.

Drag on the rim to orbit
about an axis that is
perpendicular to the
displayed view.

Single left-click to align the
center mark of the view.

2. Inside the circular rim, press down the left-mouse-button and drag in an arbitrary
direction; the 3D Orbit command allows us to freely orbit the solid model.

3. Move the cursor near the circular rim and notice the cursor symbol changes to a
single circle. Drag with the left-mouse-button to orbit about an axis that is
perpendicular to the displayed view.
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Single left-click near the top-handle to align the selected location to the center mark
in the graphics window.

Activate the Constrained Orbit option by clicking on the associated icon as shown.

The Constrained Orbit can be used to rotate the model about axes in Model Space,
equivalent to moving the eye position about the model in latitude and longitude.

v Orbit

Constraine(tg)rbit e

oS

On your own, use the different options described in the above steps and familiarize
yourself with both of the 3D Orbit commands. Reset the display to the Isometric view
as shown in the above figure before continuing to the next section.

Note that while in the 3D Orbit mode, a horizontal marker will be displayed next to
the cursor if the cursor is away from the circular rim. This is the exit marker. Left-
clicking once will allow you to exit the 3D Orbit command.

Exit marker \

[y
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Dynamic Viewing — Quick Keys

We can also use the function keys on the keyboard and the mouse to access the Dynamic
Viewing functions.

% Panning - (1) F2 and drag with the left-mouse-button
Hold the F2 function key down and drag with the left-mouse-button to pan the

display. This allows you to reposition the display while maintaining the same
scale factor of the display.

PN
Pan + <:| MOEJSE |:>
~N

(2) Press and drag with the mouse wheel

Pressing and dragging with the mouse wheel can also
reposition the display.

« Zooming — (1) F3 and drag with the left-mouse-button
Hold the F3 function key down and drag with the left-mouse-button vertically on
the screen to adjust the scale of the display. Moving upward will reduce the scale

of the display, making the entities display smaller on the screen. Moving
downward will magnify the scale of the display.

Zoom + MOUSE

(2) Turning the mouse wheel

Turning the mouse wheel can also adjust the scale of the
display. Turning forward will reduce the scale of the
display, making the entities display smaller on the screen.
Turning backward will magnify the scale of the display.
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% 3D Dynamic Rotation — Shift and drag with the middle-mouse-button

Hold the Shift key down and drag with the middle-mouse-button to orbit the
display. Note that the 3D dynamic rotation can also be activated using the F4
function key and the left-mouse-button.

Dynamic Rotation |Shift | + <:| MOUSE |:>

Viewing Tools — Standard Toolbar

| X

- View Cube

o
Full Navigation
/ Wheel

Pan \

Q.

3D Orbit

Zoom All Zoom \s
\‘

Constrained Orbit

Look At =

LM% FE B,

|m @f“%‘@@

Zoom All — Adjusts the view so that all items on the screen fit inside the graphics
window.

Zoom Window — Use the cursor to define a region for the view; the defined region is
zoomed to fill the graphics window.

Zoom — Moving upward will reduce the scale of the display, making the entities display
smaller on the screen. Moving downward will magnify the scale of the display.

Pan — This allows you to reposition the display while maintaining the same scale factor
of the display.

Zoom Selected — In a part or assembly, zooms the selected edge, feature, line, or other
element to fill the graphics window. You can select the element either before or after
clicking the Zoom button. (Not used in drawings.)
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Orbit — In a part or assembly, adds an orbit symbol and cursor to the view. You can orbit
the view planar to the screen around the center mark, around a horizontal or vertical axis,
or around the X and Y axes. (Not used in drawings.)

Look At — In a part or assembly, zooms and orbits the model to display the selected
element planar to the screen or a selected edge or line horizontal to the screen. (Not used
in drawings.)

View Cube — The ViewCube is a 3D navigation tool that appears, by default, when you
enter Inventor. The ViewCube is a clickable interface which allows you to switch
between standard and isometric views.

dOLl ¢
R

Once the ViewCube is displayed, it is shown in one of the corners of the graphics
window over the model in an inactive state. The ViewCube also provides visual
feedback about the current viewpoint of the model as view changes occur. When the
cursor is positioned over the ViewCube, it becomes active and allows you to switch to
one of the available preset views, roll the current view, or change to the Home view of
the model.

1. Move the cursor over the ViewCube and notice the different
sides of the ViewCube become highlighted and can be
activated.

2. Single left-click when the front side is activated as shown. The
current view is set to view the front side.

-% 3. Move the cursor over the counterclockwise arrow of the
ViewCube and notice the orbit option becomes highlighted.
> q . . . . .
4. Single left-click to activate the counterclockwise option as
— shown. The current view is orbited 90 degrees; we are still
viewing the front side.
-

5. Move the cursor over the left arrow of the ViewCube and notice

- the orbit option becomes highlighted.
nl I(]

h = 6. Single left-click to activate the left arrow option as shown. The
EN

current view is now set to view the top side.
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7. Move the cursor over the top edge of the ViewCube and notice
the roll option becomes highlighted.

8. Single left-click to activate the roll option as shown. The view
will be adjusted to roll 45 degrees.

9. Move the cursor over the ViewCube and drag with the left-
mouse-button to activate the Free Rotation option.

10. Move the cursor over the home icon of the ViewCube and notice
the Home View option becomes highlighted.

11. Single left-click to activate the Home View option as shown.
The view will be adjusted back to the default isometric view.

Full Navigation Wheel — The Navigation Wheel contains tracking menus that are
divided into different sections known as wedges. Each wedge on a wheel represents a
single navigation tool. You can pan, zoom, or manipulate the current view of a model in
different ways. The 3D Navigation Wheel and 2D Navigation Wheel (mostly used in
the 2D drawing mode) have some or all of the following options:

Zoom — Adjusts the magnification of the view.

Center — Centers the view based on the position of the cursor over the wheel.
Rewind — Restores the previous view.

Forward — Increases the magnification of the view.

Orbit — Allows 3D free rotation with the left-mouse-button.

Pan — Allows panning by dragging with the left-mouse-button.

Up/Down — Allows panning with the use of a scroll control.

Walk — Allows walking, with linear motion perpendicular to the screen, through
the model space.

Look — Allows rotation of the current view vertically and horizontally.

3D Full Navigation Wheel 2D Full Navigation Wheel
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1. Activate the Full Navigation Wheel by clicking on the icon as shown.

2. Move the cursor in the graphics window and
notice the Full Navigation Wheel menu
follows the cursor on the screen.

3. Move the cursor on the Orbit option to
highlight the option.

4. Click and drag with the left-mouse-button to
activate the Free Rotation option.

5. Drag with the left-mouse-button e
and notice the ViewCube also
reflects the model orientation.

6. Move the cursor to the left side
of the model and click the
Center option as shown. The
display is adjusted so the
selected point is the new
Zoom/Orbit center.

7. On your own, experiment with
the other available options.

(S&t ZoomiOrbit Cenl&rj
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Display Modes

Tools Manage View Environments GetStartd' ® The Visual Style in the View tab has

% Balanced - Ef,l Orthographic

eleven display-modes ranging from
very realistic renderings of the model

" Visual Style D shadows ~ & Ground Plane to very artistic representations of the

ions_~ i model. The more commonly used
Shaded with edges modes are as follows:

++ Realistic Shaded Solid:

e

e

stically textur

++ Standard Shaded Solid:

% Wireframe Image:

+ Wireframe with Hidden-Edges:

— = El

Wireframe with H

Orthographic vs. Perspective

\a Realistic The Bealistic szaded Solid displa}{ mode generates a high-
J R & quality shaded image of the 3D object.

Shaded The Standard Shaded Solid display option generates a shaded
Sma[th shaded m image of the 3D object that requires fewer computer
= resources compared to the realistic rendering.

Wireframe The Wireframe Image display option allows the display of the
Model edges only 3D objects using the basic wireframe representation scheme.
L

The Wireframe with Hidden-Edges option can be used to
e e generate an image of the 3D object with all the back lines
shown as hidden-lines.

Besides the above basic display modes, we can also choose orthographic view or
perspective view of the display. Click on the triangle icon next to the display mode button

on the View toolbar.

View  Environments  Get Started Collabo

High Quality ~ Q Orthographic ~ @ Texturg

(&%) =
ST Ej Orthographic
B‘ Reflections ~

A G Perspective
[
ﬂ Persp Perspective

Displays parts and|

K/
£ %4

Orthographic

The first icon allows the display of the 3D
object using the parallel edges
representation scheme.

Perspective

The second icon allows the display of the
3D object using the perspective, nonparallel
edges, and representation scheme.
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Disable the Heads-Up Display Option

The Heads-Up Display option in Inventor provides mainly the Dynamic Input
function, which can be quite useful for 2D drafting activities. For example, in the use of a
2D drafting CAD system, most of the dimensions of the design would have been
determined by the documentation stage. However, in parametric modeling, the usage of
the Dynamic Input option is quite limited, as this approach does not conform to the
“shape before size” design philosophy.

- leE}Eﬂh* - B S Y @ Genenic
30 Model  Sketch  Annotate  Inspect Tools  Manage [ 1- Select the Tools

tab in the Ribbon as
—
e @ @ Clear [ shown.

@ Adjust

Measure  Material Appearance Application Document

Options  Settings

Measure = Material and Appearance =

nspect Tools Manage View  Envirg
2. Select Application Options in the options
E@ -.'T E toolbar as shown.

Application Document Migrate  Autod
Opti i i

Application Options

Displays the Application Options

=] Application Options X
3. Select the Sketch tab
General Save File Colors Display Hardware Prompts Drawing .
Notebook SKEE‘ Part iFeature Assembly Content Center to dlsplay the sketch
T related settings.
Constraint Settings Display
[ Settings... ] B Grid lines 4. Inthe Heads- Up
8 vinor grid nes Display section, turn
Spine it method 8 s OFF the Enable
O standard ([ Coordinate system indicator Heads- Up Display,
AL Snap to Grid options
(O Minimum Energy - Default Tension Heads-Up Display and SWitCh On the
' [JJ Enable Heads-Up Display (HUD) Grid Iines’ Minor
0 100 setings.. grid lines and Axes
Dsmtoat options in the Display
| & itnnroiect ednes diring airve creation section as shown.

5. On your own, examine the other sketch settings that are available.

6. Click OK to accept the settings.
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Step 4-1: Adding an Extruded Feature

HDOD-DHS-~ - a&h

File 3D Model  Sketch  Annotate  Ing|

= & P it

i3 Loft
Start Extrude Revolve
2D Skesh ™ = Coil @,
Sketcl -
2D Sketch (5)
Model 3

Creates a 20 sketch on a planar face or
_i Partl  onawork plane on an assermnbly.
'!--EIM:::
'i"EISnlil 2D sketch places a Sketch icon inthe b
+-[T . commands on the Sketch tab to create
; Le® path. You can import image files, point
'!"EIDrig spreadsheet, or 20 AutoCAD data into |

+ W Ext

1.

Activate the 3D Model tab and select the
Start 2D Sketch command by left-clicking
once on the icon.

In the Status Bar area, the message “Select
plane to create sketch or an existing sketch to
edit” is displayed. Autodesk Inventor expects
us to identify a planar surface where the 2D
sketch of the next feature is to be created.
Notice that Autodesk Inventor will
automatically highlight feasible planes and
surfaces as the cursor is on top of the
different surfaces. Pick the top horizontal
face of the 3D solid object.

2. Pick the top face of
the solid model.

> Note that the sketch plane is
aligned to the selected face.
Autodesk Inventor automatically
establishes a User-Coordinate-
System (UCS) and records its
location with respect to the part
on which it was created.

e Next, we will create and profile another sketch, a rectangle, which will be used to
create another extrusion feature that will be added to the existing solid object.

BO-CH<e=- 084

3D Model

PRy AON

Annotate  Insj

Start Lin-eh Circle  Arc  Rectang
20 Sketch ™~ - - ¥
Sketeh Line (L) i
Model X 4+ Creates lines and arcs.
E‘ Partl Press F1 for more help

| Mode! States: [Priumsrs

3. Select the Line command by clicking once
with the left-mouse-button on the icon in
the Sketch tab on the Ribbon.
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4. Create a sketch with segments perpendicular/parallel to the existing edges of the solid
model as shown below.

v;
o
! i
N S
o
o——4
( / Ling

5. Inside the graphics window, click once with the right-

| Center Point Cirde () ) mouse-button to display the option menu. Select

o Cancel (ESC) in the pop-up menu to end the Line
L : command.

|\_General Dimension I'_'U

] -
- 6. Select the General Dimension
r Ly © & B Imag )
: command in the Sketch toolbar. The
] — - . .
Dimeasion 4 2z X 7 4 E3 pointg General Dimension command allows us
W A sl = o] to quickly create and modify dimensions.
General Dimension (D) Left-click once on the icon to activate the
Places a dimension in a 2D or 3D sketch. General Dimension command.

7. Hit the function key
[F6] once to switch the
display to the isometric

\ display as shown.
> | 8

Create the four
dimensions to describe
the size of the sketch as
shown in the figure.

o
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9. Create the two location
dimensions to describe the
position of the sketch relative to
the top corner of the solid model
as shown.

10. On your own, modify the two location dimensions to 0.0 and adjust the size

dimensions as shown in the figure below.
T

11. Inside the graphics window, click once with the right-
mouse-button to display the option menu. Select OK

&= I;‘ml'ectGeometrrJﬂ”f in the pop-up menu to end the General Dimension
command.
lension [ | 5 Project|. 12. Inside the graphics window, click once with the right-
mouse-button to display the option menu. Select

Finish 2D Sketch in the pop-up menu to end the
[ Repeat General Dimension Sketch option.
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ﬂljvErElmvcbv 0y B

3D Model  Sketch  Annotate

i E:‘; T m"" % Sweep
bl Loft

Start Elttl:g:le Revolve

2D Sketch ~ _ = Coil

Sketch | Bxtrode (B)

Model ¥+ Creates a feature or bod
profiles create solids or s

13. In the 3D Model tab select the Extrude
command by left-clicking on the icon.

Extrusion > Sketch2 9 e .
14. In the Extrude dialog box, enter 2.5 as the
¥ Input Geometry extrude distance as shown.
Profiles k [ 1 Profile o
From k 47 1 Sketch Plane

15. Click on the Flipped icon to reverse the
v Behavior Extrusion Direction as shown.

Direction A gﬂ N | o -

Distance A 2.5in [ppooeq]| L&

¥ OQutput

16. Confirm the Boolean option is set to Join and click on the OK button to proceed with
creating the extruded feature.

Properties X =+ =
. @ K
Extrusion > Sketchz De

¥ Input Geometry

Profiles k [ 1 Profile [}

(]
From k /7 1Sketch Plane |
¥ Behavior

Direction R X x -

Distance A 2.50n »E LB

¥ Qutput
Boolean o o=

» Advanced P u
l 0K ] [ Cancel I E’
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Step 4-2: Adding a Cut Feature

Next, we will create and profile a circle, which will be used to create a cut feature that
will be added to the existing solid object.

LD -DH<Ss- -
File 3D Model = Sketch  An
ENE
.;am} Extrude Revolve B
2D Sketch ™ =

Sketch
Model % 2D Sketch (5)

Creates a 20 sketch on a

1. Inthe 3D Model tab select the Start 2D Sketch
command by left-clicking once on the icon.

2. Inthe Status Bar area, the message “Select plane to
create sketch or an existing sketch to edit.” is
displayed. Autodesk Inventor expects us to identify a
planar surface where the 2D sketch of the next feature
is to be created. Pick the top horizontal face of the 3D
solid model as shown.

» Note that the sketch plane is aligned to
the selected face. Autodesk Inventor
automatically establishes a User-
Coordinate-System (UCS) and records

its location with respect to the part on

which it was created.

3. Select the Center point circle command by
clicking once with the left-mouse-button on the icon
in the Sketch tab on the Ribbon.

Line Cir
= +| Center Point Circle

4. Create a circle of arbitrary size on the
top face of the solid model as shown.
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5. On your own, create and modify the dimensions of the sketch as shown in the figure.

= wa’mmw) 6. Inside the graphics window, click once with the right-
' ' mouse-button to display the option menu. Select OK in
the pop-up menu to end the General Dimension

= s 2 jy} command.
(Undo <= ) _ L_T*"fﬂ
pimension ) | (2 _Project ce Inside the graphics window, click once with the right-
: \ — mouse-button to display the option menu. Select
LIS RIEGY Finish 2D Sketch in the pop-up menu to end the
{2} Repeat Home View Sketch option.

. Show All Degrees of Freedom .

D-EBH<Ss-=~- B
n 8. Inthe 3D Model tab select the Extrude
fC 3D Model  Sketch  Annotate command by clicking the left-mouse-button on
T:J'. T ﬁa %1 Sweep the 1con.
i Loft
Start Extlz;‘de Revolhve
2D Sketch = Coil
Sketch Extrude (E)
3 I;‘ = "
Distance A 2.50n = I A
v Outout 9. Select the CUT option in the Output -
P Boolean option list to set the extrusion
Boolean [ ] - B operation to Cut.

» Advanced Properti§ Cut

0K Cancel i
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10. Set the Extents option to Through All as shown. The A// option instructs the
software to calculate the extrusion distance and assures the created feature will
always cut through the full length of the model.

FTOMm % Z7 I SKeth Pane
¥ Behavior
Direction il M| -

Distance A  2.5i » 4B

Direction A N o -
Distance A (0.750in) * @ 14

¥ Qutput

¥ Qutput

Distance A = 2.500 in

Through All

TupaT

Boolean . ﬂ -|-+ b

11. Click on the OK button to proceed with

» Advanced Properties creating the extruded feature.

| o QJI Cancel |

e

e In Autodesk Inventor, the Extrude command can be used to create solid features
by either adding or subtracting extruded features.
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Step 4-3: Adding another Cut Feature

Next, we will create and profile a triangle, which will be used to create a cut feature that
will be added to the existing solid object.

ED*E?Eﬂq'é}*
IDModel  Sketch  An
PN E

Start Extrude Revaolve @
2D Sketch =

Sketch
Model % 20 Sketch (5)

Creates a 20 sketch on a

1. Inthe 3D Model tab select the Start 2D Sketch
command by left-clicking once on the icon.

2. In the Status Bar area, the message
“Select plane to create sketch or an
existing sketch to edit.” is displayed.
Autodesk Inventor expects us to
identify a planar surface where the 2D
sketch of the next feature is to be
created. Pick the vertical face of the 3D
solid model next to the horizontal
section as shown.

Ho-ocBs-=- 8k

Model
/' O - 3. Select the Line command by clicking once
- - "'r with the left-mouse-button on the icon in
Start Lingy Circle  Arc  Rectan the Sketch ribbon.

20 Sketch™ | T
Sketch  Line (L)

Model 3 4 Creates lines and arcs.

4. Start at the upper left corner and create three
line segments to form a triangle as shown.
(Do not align the endpoints to the midpoint
of the existing edges.)
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HAD-bH< = B

File 30 Madel Sketch  Annotate

.E| T ﬁ 5] Sweep

5. On your own, create and modify the
two dimensions of the sketch as
shown in the figure. (Hint: create the
angle dimension by selecting the two
adjacent lines and place the angular
dimension inside the desired

45,00 quadrant.)
{:L:T Two Point R.edangﬂEJ
—@ 6. Inside the graphics window, click once with the right-
(= g — mouse-button to display the option menu. Select OK in
\(g_ FroiectCeomey ) | the pop-up menu to end the General Dimension
L 90 Sketch | command.
v 7. Select Finish 2D Sketch in the Ribbon toolbar to end
Fini the Sketch option.
mat  Sket
Exit
Finish Sketch

8. Inthe 3D Model tab, select the Extrude
command by left-clicking the icon.

* b Loft
Start Extl}de Revolve
2D Sketch = Coil
Sketch Extrude (E)
L e I LB
Distance A 2.5in »E LB
¥ Qutput
Boolean & = & v

» Advanced Properti§ Cut

0K Cancel i

9. Select the CUT option in the Boolean
option list to set the extrusion operation to
Cut.
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o BN 10. Set the Extents option to To Next
Direction i | - as shown. The To Next option
DisanceA  (2som) > L [E instructs the software to calculate

: I% the extrusion distance and assures
To Next k 1 Solid To Next the created feature will always cut

. through the proper length of the
Output model.

11. Click on the OK button to proceed with creating the extruded
& feature.

Save the Model
HOo-DR< <~ &

3D Model  Skstch  &nno| 1. Select Save in the Quick Access toolbar, or you
Save (Ctrl+5) b can also use the “Ctrl-S” combination (hold down
m|

1;”+ |y the “Ctrl” key and hit the “S” key once) to save
o L

Start Extrude Revolve o the part.

2D Sketch ™ =cC

Sketch
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IT] save As
g\[ﬂ\j’:rkfpaca Save in: Parametric-Modeling - G ¥ = V 2. In the Sa\/'e AS dialOg bOX,
(1 Content Center ies | Name ’ Datemodiied  Type right-click once in the list
OldVersions 3/23/2012 2:36 PM File folder . .
area to bring up the option
menu.
View »
Sort by 3
Group by 3
Refresh
L m— T | r
File name Paste shortcut -
Save s type: Share with » :
Mew 3
FdsleE STTUTLL UL
Share with »| 3. Inthe option list, select New as shown.
Mew I} r
Properties
;  Folder
@ Shmcuk 4. In the second option list, select Folder to

create a subfolder.
@I_] Microsoft Access Database

|#  Bitmap image

Savein: | Parametric-Modeing O 5. Enter Chapter7 as the new folder

Marme Date name as shown.

| MdVersions 323

_ 2725/ 6. Double-click on the Chapter7

folder to open it.

File name: Adiust . .
huster 7. In the file name editor box, enter Adjuster

Save as type: [Mud&d{ Invertor Parts (*ipt) as the file name.

8. Click on the Save button to save the file.

«* You should form a habit of saving your work periodically, just in case something
goes wrong while you are working on it. In general, you should save your work at an
interval of every 15 to 20 minutes. You should also save before making any major
modifications to the model.
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Review Questions: (Time: 20 minutes)

10.

What is the first thing we should set up in Autodesk Inventor when creating a new
model?

Describe the general parametric modeling procedure.

Describe the general guidelines in creating Rough Sketches.

What is the main difference between a rough sketch and a profile?

List two of the geometric constraint symbols used by Autodesk Inventor.
What was the first feature we created in this lesson?

How many solid features were created in the tutorial?

How do we control the size of a feature in parametric modeling?

Which command was used to create the last cut feature in the tutorial? How many
dimensions do we need to fully describe the cut feature?

List and describe three differences between parametric modeling and traditional 2D
Computer Aided Drafting techniques.
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Exercises: (Time: 150 minutes. All dimensions are in inches.)

1. Inclined Support (Thickness: .5)

Fo—==

N
[

_/

1n

1.0
2.0
2. Spacer Plate (Thickness: .125)
6.3
3.0
L
| 4
@13
6.5

K 55
= 2.5 25

. 25

20
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3. Positioning Stop

4. Guide Block
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5. Slider Block

6. Angle Lock
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Notes:
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